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SETTING UP WORKSPACE 
 
With so many menu options and tool palettes Photoshop can be a bit daunting at first and it is hard to know 
where to start.  You really don’t need all those options visible all the time so to simplify things it is a good 
idea to set up your own workspace.  The 2 most useful palettes are your Layers palette and History palette so, 
to start with, set up your workspace with just these 2 options.  To do this go to the Window menu.  In this 
drop down menu you will see the list of palettes available.  The default settings will be shown with a tick 
beside them.  Make sure that History, Layers, Options and Tools are ticked and uncheck the rest.  You will 
need to return to the Window menu after each item has been checked or unchecked.  The end result should 
look like the image below.  Once you are happy with the set-up go to the Window, Workspace, Save 
Workspace.  You will then be asked for a name for this set-up (I simply call mine My Workspace).  Having 
saved this workspace you can play around with the other palettes at your leisure and your personal workspace 
is saved under Window, Workspace.   
 

 
 
 



 
SHARPEN IMAGE 
 
When sharpening an image it is always best to view it at 100%. 
 

Method 1 - Unsharp Mask 
 
Open Filter menu and scroll down to Sharpen, over to sub menu and Unsharp Mask.  This opens a 
new dialogue window – play around with the sliders until you get the desired level of sharpening. 

 

 
 
 
Method 2 – Edge Sharpening 
 
Duplicate layer (PC: Control J; Mac: Command J).  Go to Filter Menu, Stylise, Emboss.  New 
dialogue window appears – leave Angle and Amount at default settings (135, 100%).  Depending on 
the amount of sharpening needed, adjust the height slider.  Click ok.  Next adjust the layer mode to 
Hard Light.  It the sharpening is too intense then adjust the opacity of this layer until you are happy 
with the result. 
 



 
 
Method 3 – High Pass 
 
This is the method I use most. The level of control far exceeds the other sharpening techniques. 
 
Duplicate layer (PC: Control J; Mac: Command J).  Go to Filter Menu, Other, High Pass. New 
dialogue window appears – adjust radius until image just shows through the grey starting at a low 
pixel radius and gradually increasing. I have rarely gone over 5 pixel radius – too much here will only 
distort the image, leaving it with colour fringing (chromatic aberration) at the edges.   
 
An image that requires too much sharpening is probably a lost cause – these methods are for subtle 
enhancements. 
 

 
 
 
CROP & STRAIGHTEN 
 
Method 1 – Crop Tool 
 
 Freehand crop – select crop tool (‘C’) drag diagonally across area to be kept. Make any adjustments 
needed by dragging anchor points at sides and corners.  If any straightening is required, rotate crop 
border by moving cursor outside border.  When happy with the selection, press enter.     
 



Note: If you find the shading of the cropped away area distracting then you can toggle it on and off 
with the forward slash key. 
 
Crop to size - select crop tool (‘C’) In options bar at top of screen enter required values for width and 
height – note: you have the options of using inches, centimetres or pixels.  There is also the option of 
entering the resolution required.  Click and drag inside the border to reposition cropping area.  Press 
enter.  To remove entered values press Clear button found to the right of options bar. 
 
Create custom crop - To create a custom crop choose crop tool (‘C’).  Go to Window, Tool presets – 
this opens the tool preset palette. Go to options bar and enter required values. In tool presets palette 
press New Tool Preset button.  In the new dialogue box, enter name for preset, click OK.  Remember 
when naming preset to indicate whether it is Landscape or Portrait. 
 
Method 2 - Marquee Tool 
 
Freehand crop – select marquee tool (‘M’) drag out selection across area to be kept. Go to Image 
menu, select crop. 
 
Crop to size – The marquee tool has several handy options. Like the crop tool, you can enter size 
values but in a slightly different manner.  In the options menu there is a drop down menu with 3 
options – Normal, for random crop; Fixed Ratio, ideal for when exact size ratios are needed; and 
Fixed size, for entering specific image size (as in crop tool) 
 
Another option with the marquee tool is the ability to soften your selection.  This is done by entering a 
value in the Feather window. 
 
If, after completing your crop, you find that there is a slight gap along 1 or more edge then the Trim 
tool, found under the Image menu is a handy option.   

 

 
 

 
STRAIGHTEN PHOTO 
  
The Measure tool can be found under the Eyedropper tool and is the ideal tool for straightening a 
photo.  Open image that needs straightening and find a line that should be straight.  Click and drag the 
Measure tool along this line from left to right.  Go to Image menu, Rotate Canvas, Arbitrary.  The 
angle of the line is already displayed here, all you need to do is hit enter and Photoshop does the rest!  
Once the image had been straightened you will need to crop away the white area left by this method. 
 
 



  
 
 
CORRECT COLOUR CAST   
 
There are several ways to correct a colour cast in Photoshop and it depends on the degree of colour to 
be neutralized as to which method will work best. 
 
Important note:  Whenever you are making changes to an image it is always a good idea to use 
Adjustment Layers.  This is a non-destructive way to work on your image and still have editable 
control of the original.  You will find the Adjustment Layer icon at bottom of Layers Palette (a circle 
half black, half white).   
 
 
Method 1 – Photo Filter 
 
Go to Adjustment Layer, Photo Filter. Note:  ensure that the Preserve Luminosity option is checked.  
From here you have 2 options, it depends on the photo as to which will work best for you.  The 
quickest way is to choose one of the preset filters.  If you click on the filter drop down menu there is a 
list of presets.  Click on each to see how they affect your image.  If none of these work well enough 
then click on the Colour swatch and the Colour Picker window appears.  Move your curser over the 
portion of the image showing the greatest colour cast and click (note that your curser becomes an 
eyedropper). The values of that colour are now showing in your Colour Picker window.  What we are 
trying to achieve is a reversal of that cast so we need to reverse a couple of the values.  In this window 
you will see 2 rows of values, the ones we want are the a & b in the centre far right.  If the values are 
a positive number in these 2 windows you will need to place a minus sign in front, if they have a 
minus sign already then remove it.  This effectively creates a filter that is the opposite of the colour 
cast.  Hit OK.  Finally, by adjusting the density slider you can fine-tune the amount of the filter.   

 

 
 
Method 2 – Colour Balance 
 
Go to Adjustment Layer, Colour Balance. Note:  ensure that the Preserve Luminosity option is 
checked.   



 
 
With this method you have a finer control with options for Shadows, Midtones and Highlights.  Click 
on each in turn (starting with Midtones) and adjust the three colour sliders according to needs.  
Remember this is an adjustment layer so you can come back to it at anytime to make further 
corrections. 
 
 
 
 
 
 
 
 
Method 3 – Selective Colour 
 
Go to Adjustment Layer, Selective Colour.  With this tool you have control over each aspect of each 
colour.  Click on the drop down menu and choose the problem colour, adjust the slider controls 
slightly then repeat process in the Neutral window.  This takes a bit of practice; each photo will need 
different adjustments, just play with the sliders until you are happy with the result. Hit OK.  
Remember, being an adjustment layer you can go back and fiddle some more. 
 

 
 
 
CORRECT UNDER/OVER-EXPOSED SHOTS 
 
Method 1 – Blending Modes 
 
A quick and easy way to make adjustments on either an under or over exposed shot it to use Blending 
Modes.  First duplicate your layer (PC: Control J; Mac: Command J).  Working on the new layer go to 
the Blending Mode drop down menu (at the top left of the layers palette).  For under exposed shots 
(too dark) change Blending Mode from Normal to Screen; for over exposed shots (too light) change 



Blending Mode from Normal to Multiply (there is a possibility that you will need to repeat this 
process).  Don’t worry if the adjustments are too extreme, adjusting the opacity level will sort this out.  
Note: the opacity slider is at the top right of the Layers palette. 
 
Method 2 – Levels Adjustment 
 
Go to Adjustment Layer, Levels.  Notice in the image below (for an over exposed shot) that the 
histogram shows a blow out in the Dark end of the graph.  With this I would move the dark slide over 
towards the beginning of the black.  Make a slight adjustment to the light slide and then the mid tone 
slide until you are happy with the result.  Note:  with an underexposed shot the histogram would show 
problems on the light side of the graph. 

 

 
Method 3 – Shadow/Highlight 
 
This one takes practice but the results are worth it.  Go to Image, Adjustments, Shadow/Highlight.  
Adjusting the 2 sliders shown here give a general result.  Click the Show More Options button to open 
a more comprehensive window.  The best way to learn this is just to play with it until you are happy 
with the result. 
 

 
 
 
 
RED EYE REDUCTION 
 
Zoom in on eyes, go to brush tool and choose a soft brush.  Make sure that your Foreground colour is 
black (hit ‘D’ to revert to default colours).  In Options Bar change brush Blend Mode to Colour.  With 
brush tool dab at the eye until red is removed. 
 
REMOVE BLEMISHES  
 
Duplicate layer.  Zoom in to area to be removed.  Start with the Clone Tool (rubber stamp icon in Tool 
Bar); hold Clone Tool over area close to the blemish and of similar colouring.  Hold Alt Key (Mac: 
Option Key) and click – this gives you a source for the Clone tool to work from – then click over the 
blemish to be removed.  The Clone tool replaces the area with that from your source point.  This can 
be a bit rough so next, go to the Healing Brush Tool (bandaid icon in Tool Bar).  Use this in the same 
way as the Clone Tool to smooth out any obvious markings left by the Clone Tool.  In some cases you 



can get away with using one or the other of these tools but I like to use both – the Clone Tool is a get 
down and get dirty way of starting off and then you can refine the result with the Healing Brush. 
Note:  This is a great method to remove objects from a photo such as a sign or person in the 
background.  Just remember to keep your Clone size relatively small – it takes longer but the 
end results are much smoother. 
 
 
CONVERT TO B&W  
 
Once again there are several ways to do this in Photoshop.  The quickest and easiest is to use the 
Desaturate option (Image, Adjustments, Desaturate) but this is a general adjustment and gives no fine 
control.  Another quick method is to use a Hue/Saturation Adjustment Layer, simply pull the 
saturation slide right over to the left.  If the result is too dark you can then play with the lightness 
slider.  By far the best method of converting a colour file to B&W is to use A Channel Mixer 
Adjustment Layer. 
 
Go to Adjustment Layer, Channel Mixer.  In the new dialogue window you will see sliders for the 3 
source channels – Red, Green and Blue – and, above that the drop down for the output channel.  To 
convert to B&W first check the Monochrome button at the bottom left.  You will note that the Output 
Channel is now set to Grey and your image has changed to B&W.  But this is where the fun starts.  By 
playing with the sliders you will see that you can control the individual colour makeup of the B&W 
file.  By adjusting these sliders your result will have far better depth and clarity.  Also slight 
adjustments to the Constant slider at the bottom will adjust the brightness.  Note:  Technically the 
combined values of the 3 channels should total 100% 
 

 
 
 
CUSTOM ACTIONS 
 
Over time you will notice that you are repeating a certain action over and over again. To eliminate the 
necessity of going through the same process, step by step, with each file you can create a Custom 
Action.  To demonstrate this we will create a Custom Action to resize your image by 110%.  This is a 
nifty way of increasing a small file in order to print enlargements but without any reduction in quality 
that would occur if you made one huge adjustment.  By increasing in 10% increments you are 
eliminating any possibility of blurring or pixelating.  In creating a Custom Action this process is done 
for you at a press of a button. 
 
Go to Actions Palette (by default it is next to your History palette but you may have set it up 
elsewhere.  If you can’t see it on your workspace then go to Window and check the Actions option).  
Firstly click on the folder icon at the bottom of the palette to create a New Set, give the set a name (I 
call mine My Actions – creative aren’t I?), this is where you can place all of your own Custom 
Actions.  Once this is done then we start on the Action itself.  Go to the New Action icon (next to New 



Set icon).  In the new window you are prompted for a name for your action (here we will call it Upsize 
110%)  Go to the drop down menu for Sets and choose your actions set.  Next, give the Action a 
Function Key (f11 is generally a good one).  Press record – your action is now being recorded so 
every step you take will be in your Custom Action, this one is quite simple but in a more complicated 
action it is best to map out your moves beforehand to eliminate mistakes and the need to re-record 
your action.  Go to Image, Image Size.  In the new window you will see the current size values for 
your image.  In Document Size, change measurement to Percent, change value to 110%, under 
Bicubic change to Bicubic Smoother for better enlargement (note if reducing the size of a file then 
Bicubic Sharper is the best option) Press OK. 

 
 

 
Your image will now be upsized by 10%.  Go to Actions Palette; Click the square Stop button at 
bottom of palette.  Your New Action is now set to the Function key chosen, each time you press that 
your image will be increased by 10%.  To upsize a photo from 5x7 to poster size you will need to 
repeat this process several times – this is where the Custom Action saves you a lot of time and 
fiddling around.  
 
As I said earlier, Custom Actions can be created for almost any action that you find repetitive and 
time consuming.  You do not need to allocate a Function Key; your Actions will be saved under your 
Action Set in the Actions Palette. 
 
 
BATCH PROCESS 
 
With Batch Processing you can take an Action and apply it to an entire folder of photos.  This is great 
if you have a Custom Action to sharpen images from a specific camera – the settings will be the same 
so, instead of opening each file and using the Custom Action, Photoshop has automated the process 
for you. 
 
Without opening an image, go to File, Automate, Batch.  In the new dialogue window choose the 
action you want to apply.  Next click on Choose… and you will be taken to a browser window to 
search for the folder you want the action applied to.  Under destination choose Save & Close.  Press 
OK and sit back while Photoshop does all the work. 
 
Note:  This process will save over your original file so if you want to retain the original, copy all 
files to a different folder and use this to apply the action. 
 



 
 
 
 
 
 
 
 
 
 
LAYERS 
 
It can be hard to wrap your head around the process of using layers but they are an invaluable tool in 
Photoshop and many other programs. Imagine a layer as an image placed on transparent sheet, which 
you can lay on another transparent one. Each layer is a separate image, which can be modified 
independently without affecting images from other layers. The final image (which we see) is a view of 
the layer stack from the top down. 

 
 



 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Photoshop Training & Tutorials 
 

Scott Kelby – Several excellent books on PS - editor and publisher of Photoshop User Magazine, Layers 
magazine (the how-to magazine for everything Adobe® 
 
http://www.scottkelby.com/books.html 
 
 
Photoshop Elements TV – Great video tutorials 
 



http://www.photoshopelementsuser.com  
 
 
Photoshop Roadmap News –Click on “Subscribe Here” and once you have registered your email address 
they send links on a regular basis to all manner of free tutorials, plugins and brush sets. Range from good to 
excellent – beginner to advanced  
 
http://www.photoshoproadmap.com/Photoshop-tutorials 
 
G3 Fusion - Especially good for beginners – starts with all the tools then progresses to using layers.  Shows 
how to use text with various effects and even gives you sample shots to download and practice with. 
 
http://www.g3fusion.com/?p=8 
 
Watch & Learn Photoshop – Excellent video tutorials.  They have a certain amount of freebies that you can 
subscribe to or purchase any of their fantastic Training Collections. 
 
http://watchandlearnphotoshop.com  
 
Sitepoint – have a good tutorial for beginners, it explains the workspace, palettes and layers and heaps more. 
 
http://www.sitepoint.com/article/getting-started-photoshop  
 
 
 
I have found that by following links on most of these sites you can discover all manner of great Photoshop 
tutorials – from beginner to advanced – or, as my daughter is always telling me “Google is your friend!”   
 
 
 
 
 
 
 
 
 
 
 
 

 


